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Introduction 
 
This guide assumes several things. Firstly, you know exactly what the iTunes Music Store is and why you 
want your music to be there. Secondly, you know your way around an Apple Macintosh G4 running Mac 
OS X. Thirdly, you already have your music product bar-coded and shrink-wrapped. Fourthly, you have a 
thick and hardened skin from many years of practical experience in the music industry. Finally, you will 
need a sense of humor. Preferably a lemon flavored one. You have been warned. 
 
We’ll start with some temporal exercises in reality. If you are reading this, then not only have you made 
the decision (no doubt against rational advice) to be involved in the music industry, but also you’re naive 
enough to think that you can make some money at it as well. 
 
Good! Now we have that out of the way, there are some things to consider. There are some realities that 
just can’t be avoided. One is the possibility that you really suck. Or rather, your music really sucks. This 
will provide a slight challenge at getting past that American Idol audition, getting that elusive Grammy or 
having your music become that billion-selling multi-titanium hit that all your friends say you deserve. It’s 
quite possible that after you’ve painstakingly gone through the entire process described in this 
publication, that Apple would reject the music you finally submit. It might be on technical grounds. Or it 
might just be that you’ve pushed the boundaries of artistic freedom way beyond anything that anyone at 
Apple understands. This guide can’t stop you from sucking. Nor can this guide change any of Apple’s 
criteria for screening the music that is finally submitted to them. 
 
The Internet is the great equalizer. Or so they tell us. It has allowed thousands upon thousands of new 
artists to emerge and receive exposure. Great bands and great music exist alongside… er… some things 
that I wish I’d never ever listened to let alone downloaded. Some of these artists have been excellent and 
leave me wondering why they haven’t got The Deal™, while some others, who were really bad, left me 
wondering why they had got The Deal™. Having said that, some of these Really Bad Artists™, that would 
otherwise have never had any exposure, have been distinctive enough to be featured in primetime TV 
commercials. These contradictions are a daily experience. Ultimately, this is good news for all those using 
the Internet because the broader tastes of today’s audience can now be catered to, free of the filtering by 
the major labels. 
 
Unfortunately, iTunes isn’t the Internet. It’s much more like America Online. It’s a self-contained, closed 
and proprietary system that has the potential to expose your music only to those people who have the 
iTunes client software installed and have created an online account. So far, Apple hasn’t made their 
digital rights management system (Fairplay) available to other vendors. 
 

Remember all 
this when the 
world doesn’t 
come banging 
on your door 
immediately 
after you upload 
your music.

Apple Macintosh computers now come with iTunes installed. That’s about 3% of 
the computer market. There is no Linux version so that leaves out about another 
3%. The other 94% will need to download and install the iTunes software. 
Assuming that Windows remains stable enough to install and run iTunes, the user 
has a stable Internet connection and a credit card that isn’t maxed out, it’s quite 
possible that some of these users will go beyond ripping their own CD collection 
and actually visit the iTunes Music Store. Then there are territorial rights issues 
which are managed by only selling music to consumers who have a credit card 
billing address within the same territory. After all that, this sub-fraction of consumers, still have to be able 
to find your music and pay for it. To accomplish this, your music needs to be on iTunes in the first place. 
After all of that, you still need to drive people directly to your music. This is what this guide is all about. 
 
So what really makes iTunes Music Store attractive in all of this? Well, probably the main thing is that they 
pay money back to the copyright owner for songs downloaded. In practice, if the purchase price for a 
song is $0.99, then the iTunes Music Store will pay the record label a wholesale price of $0.65. 
Theoretically, a portion of this money is contractually obligated to pay the songwriter(s), musician(s), 
band(s), and any sub-labels or production companies that are involved. It’s rather a novel concept in the 
music industry. Getting paid, that is. 
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About iTunes – The Business 
 
This section is here to provide some kind of idea of what Apple has done and/or is 
planning to do with iTunes and the iTunes Music Store as a business. Since Apple is a 
publicly traded company (NASDAQ: AAPL), one of the best places to find this kind of 
information is in the legal documents that must be filed with the U.S. Securities And 
Exchange Commission. It’s worth taking note of some of the things that Apple say 
because they could materially affect your business plans once your music is available 
through the iTunes Music Store. 
 
The following information was published in Apple Computer Inc.’s 10-K filing (annual 
report) with the U.S. Securities And Exchange Commission for the financial year ending 
on September 30, 2006. This is how Apple describes itself to investors pursuant to 
Section 13 or 15(d) of the Securities Exchange Act of 1934. This filing can be found via 
http://www.apple.com/investor/ at: 
 
http://media.corporate-ir.net/media_files/irol/10/107357/reports/10K_FY2006.pdf
 
The following information can be found under Consumer, Education and Business 
Oriented Application Software on page 14 of the 10-k: 

iTunes®

iLife ‘06 also includes iTunes, the Company’s digital music jukebox software application that allows users to 
purchase a variety of digital content available through the Company’s iTunes Store. iTunes organizes 
content using searching, browsing, and playlists, and also includes features such as iMix playlist sharing and 
provides integration with the complete family of iPods. In September 2006, the Company introduced iTunes 
7, the latest version of its iTunes software. iTunes 7 delivers new features such as album and Cover Flow 
views of music, television shows, and movies, enabling users to quickly find titles in their library as well as 
casually browse through titles they already own. 

 
The following information can be found under Music Products and Services on page 
11 of the 10-k: 
 

The Company offers its iPod® line of portable digital music players and related accessories to Macintosh 
and Windows users. The Company also provides an online service to distribute third-party music, audio 
books, music videos, short films, television shows, movies, and iPod games through its iTunes Store. In 
addition to the Company’s own iPod accessories, thousands of third-party iPod compatible products are 
available, including portable and desktop speaker systems, headphones, car radio solutions, voice 
recorders, cables and docks, power supplies and chargers, and carrying cases and armbands. 

iPod®

The iPod is the Company’s hard-drive based portable digital music player and was updated in September 
2006. The iPod is available in a 30GB model capable of holding up to 7,500 songs, 25,000 photos, or 75 
hours of video, and an 80GB model capable of holding up to 20,000 songs, 25,000 photos, or 100 hours of 
video. The iPod features up to 20 hours of battery life and includes a 2.5-inch color screen that can display 
album artwork, photos, and video content including music videos, video and audio podcasts, short films, 
television shows, movies, and games. Other key features of the iPod include a calendar ,  contact utility, and 
data storage capability. The iPod features the Company’s patent-pending Click Wheel, a touch-sensitive 
wheel with five push buttons for one-handed navigation. The iPod also includes the Company’s patent-
pending Auto-Sync technology that automatically synchronizes and updates the iPod’s digital music and 
other content whenever it is connected to a Macintosh or Windows computer via USB. All iPods work with 
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the Company’s iTunes digital music management software (“iTunes software”) available for both Macintosh 
and Windows-based computers. 

iPod® nano 
In September 2006, the Company introduced the second-generation version of its flash-memory-based iPod 
nano featuring an aluminum body and up to 24 hours of battery life. The second-generation iPod nano 
includes the Click Wheel, a smaller and lighter design, a brighter color screen than its predecessor, and new 
Search and Quick Scroll features that make it easier to find content. The iPod nano is available in 2GB, 4GB 
and 8GB configurations and in a variety of colors. 

iPod® shuffle 
In September 2006, the Company introduced a new version of its flash-memory-based iPod shuffle. The 
new iPod shuffle weighs half an ounce and features an all-new aluminum design and a built-in clip. The new 
iPod shuffle contains one gigabyte of flash memory capable of holding up to 240 songs and provides up to 
12 hours of battery life. The iPod shuffle is based on the Company’s shuffle feature that allows users to 
listen to their music in random order. iPod shuffle works with iTunes and its patent-pending AutoFill option 
that automatically selects songs to fill the iPod shuffle from a user’s iTunes library. 

iTunes Music Store®

The Company’s iTunes Store, available for both Macintosh and Windows-based computers, is a service that 
allows customers to find, purchase, and download third-party digital music, audio books, music videos, short 
films, television shows and movies, and iPod games. The iTunes Store also features the Podcast Directory 
that allows customers to search for and download audio programs to their computers and automatically 
receive new episodes over the Internet. Customers can search the contents of the store catalog to locate 
works by title, artist, or album, or browse the entire contents of the store by genre and artist. Originally 
introduced in the U.S. in April 2003, the iTunes Store now serves customers in 22 countries. 
 
The iTunes Store is fully integrated with iTunes software allowing customers to preview, purchase, 
download, organize, share, and transfer digital content to an iPod using a single software application. 
Further discussion of the iTunes software may be found below under the heading “Software Products and 
Computer Technologies.” The iTunes Store offers customers a broad range of personal rights to the third-
party content they have purchased. Content purchased through the store may also be used in certain 
applications such as iPhoto®, iMovie®, and iDVD®. Additional features of the iTunes Store include gift 
certificates that can be sent via e-mail; prepaid music cards; an “allowance” feature that enables users to 
automatically deposit funds into an iTunes Store account every month; online gift options that let customers 
give specific content to anyone with an email address; parental controls; and album reviews. 

 
The following information can be found under Competition in the Markets and 
Distribution section on page 17 of the 10-k: 
 

The Company’s music products and services have faced significant competition from other companies 
promoting their own digital music and content products and services, including those offering free peer-to-
peer music and video services. The Company believes it currently retains a competitive advantage from 
innovation and by more effectively integrating the entire solution including the hardware (personal computer 
and iPod), software (iTunes), and distribution of content (iTunes Store). However, the Company expects 
competition in this space to intensify as competitors attempt to imitate the Company’s approach to tightly 
integrate these components within their individual offerings or, alternatively, collaborate with each other to 
offer solutions that are more integrated than those they currently offer. Some of these current and potential 
competitors have substantial resources and may be able to provide such products and services at little or no 
profit or even at a loss to compete with the Company’s offerings.
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The following information can be found on page 26-27 the 10-k: 
 

Third-party Music Content 
 

The Company relies on third-party music content, which may not be 
available to the Company on commercially reasonable terms or at all. Here Apple is telling the 

world that you, as a 
content provider, have 
Apple by the short and 
curlies. Even though this is 
theoretically true, the 
reality is that if you are not 
in the iTunes Music Store, 
someone else’s music will 
show up in exactly the 
spot where your music 
would eventually be. 
 
Apple are also saying they 
may not be able to keep 
up with changes needed to 
implement Digital Rights 
Management, especially 
since their closed system 
is being challenged in 
Europe. Consequently, if 
Apple’s DRM fails or is 
removed, it’s possible that 
your songs may fall 
through the cracks and not 
get properly tracked, at 
which point there is the 
potential for litigation. All of 
this is covered in their 
contract, but at least you 
are better prepared in 
dealing with it. 

 
The Company contracts with third parties to offer their digital content 
to customers through the Company’s iTunes Store. The Company 
pays substantial fees to obtain the rights to offer to its customers this 
third-party digital content. The Company’s licensing arrangements 
with these third-party content providers are short-term in nature and 
do not guarantee the future renewal of these arrangements at 
commercially reasonable terms, if at all. Certain parties in the music 
industry have consolidated and formed alliances, which could limit the 
availability and increase the fees required to offer digital content to 
customers through the iTunes Store. Some third-party content 
providers currently or may in the future offer music products and 
services that compete with the Company’s music products and 
services, and could take action to make it more difficult or impossible 
for the Company to license their digital content in the future. Further, 
other distributors of third-party content or third-party content owners 
may seek to limit the Company’s access to or increase the total cost 
of such content. If the Company is unable to continue to offer a wide 
variety of digital content at reasonable prices with acceptable usage 
rules, or continue to expand its geographic reach outside the U.S., 
then sales and gross margins of the Company’s iTunes Store, as well 
as related hardware and peripherals, including iPods, may be 
adversely affected. 
 
Third-party content providers and artists require that the Company 
provide certain digital rights management (“DRM”) solutions and other 
security mechanisms. If the requirements from content providers or 
artists change, then the Company may be required to further develop 
or license technology to address such new rights and requirements. 
In addition, certain countries have passed legislation or may propose 
legislation that would force the Company to license its DRM solutions 
so that content would be interoperable with competitor devices, which 
could lessen the protection of content subjecting it to piracy and could 
affect arrangements with the Company’s content suppliers. There is 
no assurance the Company will be able to develop or license such 
solutions at a reasonable cost and in a timely manner, if at all, which 
could have a materially adverse effect on the Company’s operating 
results and financial position. 
 

 
It’s also worth reading the long Legal Proceedings section that starts on page 33. There are a 
number of lawsuits involving Apple, including some that may directly affect the iTunes Music 
Store. 
 
Lastly, the 10-k also states that the European Union is investigating why the UK iTunes store 
charges more in £ (pounds sterling) than the European iTunes store charges in Euros (which is 
in violation of EU law). Doesn’t that make the UK a much better market to sell in? Not 
necessarily. For U.S.-based labels, the European store actually pays out the most and the 
Canadian store pays out the least. Why? Because of the current exchange rates of the Euro 
and Canadian dollar against the US dollar. Of course, this all depends on how the exchange 
rates fluctuate against your own local currency and how you choose to receive your income. 
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Before Starting 

Either… 
 
You will need the following to apply to the iTunes Music Store: 
 

1. A company (i.e. record label or production company) in the business of selling music legally  
2. A web browser to fill out the application form 
3. An authorized representative of 1. above who can submit and sign the online form 
4. Valid contact information (including an email address) 
5. Printer and paper 
6. A big envelope and enough postage to send the contract back 
7. Patience 

 
You will need the following after your contract with iTunes Music Store has been 
counter-signed by the Apple Legal Team: 
 

1. High quality masters of the music (either on CD or hard-drive) 
2. An iTunes / Apple Developer Connection account (this is supplied by Apple) 
3. 12 digit UPC code or 13-digit EAN (i.e. a retail bar code) assigned to your music product 
4. ISRC codes assigned to each individual track 
5. All the liner notes and credits that apply to your music (lyrics, who did what, etc.) 
6. Someone who can encode and upload your music 
7. Patience 

Or… 
 
You will need ALL of the following if you want to do everything yourself: 
 

1. A company (i.e. record label or production company) in the business of selling music legally 
2. A web browser to fill out the application form 
3. An authorized representative of 1. above who can submit and sign the online form  
4. Valid contact information (including an email address) 
5. Printer and paper 
6. A big envelope and enough postage to send the contract back 
7. High quality masters of the music (either on CD or hard-drive) 
8. 12 digit UPC code or 13-digit EAN (i.e. a retail bar code) assigned to your music product 
9. ISRC codes assigned to each individual track 
8. All the liner notes and credits that apply to your music (lyrics, who did what, etc.) 
10. The following hardware/software configuration is required to use iTunes Producer 1.5.1: 

a. Power Mac G4 (or higher) 
b. At least 512 MB RAM 
c. Mac OS X version 10.4.5 (or later) 
d. QuickTime version 7.0.3 (or later) 
e. Administrative rights to computer 

11. Patience 
 
 
If you don’t have all of these - stop and get them. If you think the 
requirement of a Power Mac is a deal killer, jump ahead to the 
iTunes Producer section of this guide. 
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The Application Process 
 
When the iTunes Music Store first opened, the process was fairly primitive. First you 
had to apply to Apple for the application form. That’s right. You had to apply to apply. 
Then when the application form came back you had to fill it out and submit it into the big 
black empty void of all application forms. Then you sat and waited. And waited. 
 
 
Fortunately, Apple have now put their application form online: 
 
https://phobos.apple.com/WebObjects/MZLabel.woa/wa/apply
 
 
It’s as simple as hitting the “Apply” button. You can find the form on the Apple web site 
via the iTunes page (note that it is a secure connection so your submission remains 
confidential). Unfortunately the waiting part hasn’t changed… 
 
 
 

 
 
 
 
 

Only fill out the application form if you own or control a catalog of sound 
recordings, or are an authorized representative of someone who does. If 
you cannot license the recordings for digital distribution DO NOT fill out 
the application form. You’re just wasting yours and Apple’s time. 
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There are a couple of things to note here. You will be dealing 
almost entirely with Apple’s legal team. That’s right. They are 
lawyers. They may or may not have a sense of humor, but 
they have a reputation for having very sharp teeth. They have 
a job to do to prevent your music (and other people’s music) 
from being ripped off through the iTunes Music Store. Apple 
will only deal with the people who own or control the rights to 
the music being submitted. If you don’t own the rights to 
your music (I’m not joking), then you will need to work 
with those that do have those rights. 

I’ve had a number of 
calls from people who 
said their music was 
being sold in the iTunes 
Music Store and they 
didn’t know how it got 
there. In each case, their 
music had been put 
online by someone who 
they had previously 
given “rights” to.

 
 
The application form itself is pretty self-explanatory. You will need to tell Apple exactly 
who you are and who you represent by providing all your contact information. Be as 
thorough as possible. 
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Notice that Apple is asking you about your role. You can now apply to the iTunes Music 
Store as an independent artist or group, a record label or a distributor. If, and I stress if, 
you decide to self-publish your music, or be your own record label and distributor, you’d 
better know the whole game ahead of time. This guide is not going to help you 
understand the basics of copyright or digital distribution rights. This could be a big 
problem for you if you’re not business savvy. 
 
Also note that Apple specifically asks you about your territorial rights. This is very 
important as it relates to the availability of the iTunes Music Store. At the time of writing, 
the iTunes Music Store is only available in a limited number of countries (see the next 
page for the current list). Also, you will be required to sign a separate agreement for 
each geographic iTunes Music Store and also the related foreign tax forms. 
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* At the time this edition was printed, the 
following iTunes Music Store territories 
were open for business: 
 

• United States 
• Canada 
• United Kingdom 
• Australia 
• New Zealand 
• Japan 
• Europe 

 
The European iTunes Music Store is 
open for business in the following 
countries: Austria, Belgium, Denmark, 
Finland, France, Germany, Greece, Italy, 
Ireland, Luxembourg, Netherlands, 
Norway, Portugal, Spain & Switzerland. 
 
Don’t forget, you’ll need to sign a 
separate agreement for each iTunes 
Music Store territory. 

This sounds more complicated than it is (really), but if 
you don’t have the rights for your music in a country 
where there is an iTunes Music Store*, your music 
won’t be available there until the rights holder puts it 
there. Sometimes this happens when the artist is 
signed with a label for a specific geographic region 
(territory). 
 
Let’s use a purely hypothetical example - the artist is 
signed to Label A in North America and Label B in 
Europe, while retaining the rest of the world for their 
indie label (Label C) which is run from their web site. 
In this case, Label A will submit the music to the US 
& Canadian stores, Label B will submit the music to 
the European stores, while the artist’s own Label C 
will submit the music to all the other iTunes stores. 
Label C may have to wait until an iTunes store opens 
for some of the territories it has rights for (such as 
Japan), before its music goes on sale there. Sound 
like fun? What do you mean, no? 
 
Do yourself a favor and keep your worldwide rights if 
you can. You will need them. 
 
Why is all this relevant? Well, Apple enforces the territories using the consumer’s credit card 
billing address. Someone with a US billing address can only buy from the iTunes US store (and 
pay in US dollars). Likewise, someone with an Italian billing address can only buy from the 
iTunes European store (and pay in Euros). 
 
Got it? Good. 
 
On the next page of the form, Apple want some demographic information from you, namely your 
musical genres, how many albums and individual tracks as well as an artist/label roster. Note 
that the numbers are estimates but they should be realistic. If you have ten CDs already 
released and two more coming out next year, it’s reasonable to put down the number 12. The 
same goes for the number of tracks. But don’t go silly here. Don’t put down ten CDs when you 
only have half a CD completed. 
 
There’s a space for additional information. If you have a Grammy, this is where you mention it. If 
you have been featured or are getting your music played on TV, this is where you mention it. If 
you are supporting or headlining a national tour, this is where you mention it. You should this 
section to best represent the artist/group/label/distributor. However, don’t make stuff up. There’s 
always the minor detail of getting Apple’s fine legal experts to believe everything you tell them. 
 
So, the first step is groveling profusely to Apple. Remember, this is just the first step. Apple will 
expect you to get much, much better at groveling as time goes on as you go through the 
process of getting your music into the iTunes Music Store. Ready? 
 
Off you go… 
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The Contract 
 
Once you receive a response from Apple, it will thank you for your application, tell you how excited the 
iTunes Music Store is to work with you, and provide a set of instructions. It will most likely arrive as an 
email, so make sure your spam filters don’t delete it, because it will include your Apple Contract 
Number. There will also be three very important attachments: 
 

1. Cover Sheet (1 page) 
2. iTunes Agreement (varies depending on territory) 
3. Vendor EFT Form (1 page) 

 
It’s very important to note at this point that you are going to be a vendor to Apple. That’s right. You are 
establishing a business relationship as a vendor to a NASDAQ listed company. You’re not peddling boxes 
of product to your high school buddy who’s now working at the local record store. Things have to be done 
rather more carefully now. 
 
Unless Apple has changed its procedures since this was written, the following things now need to be 
done: 
 

1. Fill in the Cover Sheet with your Apple Contract Number (included in the email you received) and 
your company contact information. Make sure this is as complete as possible and include phone 
and fax numbers as well as email addresses for all contacts. 

 
2. Fill out the Vendor EFT Form. This is the Electronic Funds Transfer (EFT) form and it authorizes 

Apple to deposit the money they owe you into your bank account. This is how you get paid. Don’t 
screw this form up or you won’t get paid. 

 
3. Print out two (2) copies each of the Cover Sheet and the iTunes Agreement. 

 
4. Have a duly authorized representative of your company sign the signature page of both iTunes 

Agreement copies AND the Vendor EFT Form.  
 

5. Fax one copy of the completed Cover Sheet, the signed iTunes Agreement signature 
page (only), and the Vendor EFT Form to the number Apple provide. 

 
6. Mail the two original, signed, complete iTunes Agreement copies, with Cover Sheets 

attached, and the completed and signed Vendor EFT Form to Apple. 
 

Apple will have the original agreements counter-signed and return one of them for your records. If you 
have any questions about the legal paperwork, you can send and email to the email address provided. 
 
Apple will then enter the information from your Vendor EFT form into their accounting system and then 
they will get back to you. In the meantime… 
 
…you wait… 
 
…and then - providing the paperwork was filled in correctly, faxed and mailed correctly and the wonderful 
people at Apple don’t have any problems with your application - someone from the iTunes Team will then 
contact you. You will receive a countersigned copy of your contract as a PDF sent to your email address 
(this is still legally binding). This process can take a few weeks. Just be thankful Apple have streamlined 
the process - it used to take several months to receive the contract. Also, while you may find you have a 
signed contract and access to upload your material, it probably won’t be available for sale immediately. 
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iTunes Producer 
 
 

Now, it’s getting exciting. If everything goes smoothly, you will receive an 
email with instructions on the next step. You will need to download the latest 
version of the iTunes Producer software. 

 
iTunes Producer is a free software application that allows you to prepare your music for 
submission to iTunes. It’s less than a megabyte to download, partly because it doesn’t 
have any of the normal features from iTunes. It’s a stripped down version that is 
designed strictly for producing content for the iTunes Music Store.  
 
Of course, it’s only available for the Macintosh. I’ve had numerous complaints about this 
and there are two responses I give out. One is “talk to Apple”. The other is “how 
important is your music to you?” Seriously. You know the music industry can be 
distasteful at times. You know there is always someone out there who wants to collect 
your royalties before you do. You know you have to work a little bit harder than the next 
guy/girl/band/label (who probably doesn’t sleep either). OK, so you need a Macintosh to 
upload your songs into the iTunes Music Store. Then borrow one, rent one, or buy one 
(but don’t steal one – some would call that bad karma). Apple even has special 
discounts available if you want to buy one (plus Apple now includes the Garage Band 
music software free). If money is tight, and it always is, it will only take a couple of hours 
to encode and upload your music so one of the other options might work for you. If your 
music is important enough, you can find a way to do this part. 
 
ITunes Producer automatically encodes your digital masters into Apple’s AAC digital 
music format. You will use it to: 
 
 

1. encode your music into AAC format 
 
2. enter the album information 
 
3. enter the song information 
 
4. enter the primary artwork 
 
5. send all your prepared files directly to Apple for consideration 

 
 
Note that last item. Once you’ve got this far, signed the contracts, prepared your music 
and submitted it to Apple, it’s still not over. Apple still has the final say as to whether 
your music will appear in the iTunes Music Store. After all this, the deal killer might not 
be the lack of a Power Mac after all. 
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Create Your iTunes Artist & Labels Account 
 
This is where you will need the email that you were sent. It contains the username and 
password information that you need to log into the iTunes Artists & Labels web site. 
From here you can download the iTunes Producer software. You will also need this 
account information to upload your music to Apple from the iTunes Producer software. 
 
 
It looks like this: 

 
Label: [Your Record Label Name] 
 
Apple ID: [Your Apple ID] 
 
Password: [Temporary Password]  

 
 
During this initial login, you will first have to accept the 
terms and conditions of the iTunes Artists & Labels web 
site. You will enter your correct contact information and 
you will also be prompted to change your password. 
Write down your new password as you will not be able 
to retrieve it once it is created. Let’s repeat this part as 
it is important. 

If you need another incentive 
to keep this information 
secure, just think of someone 
else logging into your account 
and changing your account 
details so they get paid for 
your music instead of you. 

 
 
 

Write down your new password somewhere safe. You will not be able to 
retrieve it once it is created. Also, DO NOT give out your Apple ID and 
password to anyone under any circumstance, as it is covered under your 
iTunes Agreement with Apple. 
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Downloading iTunes Producer 
 
Once you've logged in to the iTunes Artists & Labels web site and set up 
your account, you can download the iTunes Producer software. The site 
login can be found here: 
 
http://www.apple.com/itunes/go/labelconnect/
 
 
Once you login you’ll see a button for the iTunes Producer software and another button 
for the Using iTunes Producer  read me file (this is a PDF). A third button takes you to 
the Apple store for hardware and software discounts linked to your account. 
 
 
At the time of publication (March 2007) Apple is distributing iTunes Producer v1.5.1. It’s 
about a 1MB download. Apple will soon be requiring that all new content be delivered 
with iTunes Producer 1.5.1. 
 
 
iTunes Producer includes the following features: 
 

• Encodes music in Apple Lossless format 
• Improved performance & connectivity (means getting your music on the Music 

Store faster and easier). 
• Territory Rights: Assign digital rights clearance information to each playlist in 

preparation for selling your music in iTunes Music Stores worldwide. 
• Review all the data you've entered for each playlist and save it as a text file. 
• Indicate tracks as "Part of a Gapless Album" for gapless playback in iTunes.  
• Import data from a tab-delimited file directly into your playlists 
• Set Sale Start Dates on a per-country basis 
• Display upload progress 

 
 
iTunes Producer 1.5.1 requires the following hardware/software configuration: 
 

1. Power Mac G4 (or higher) 
2. At least 512 MB RAM 
3. Mac OS X version 10.4.5 (or later) 
4. QuickTime version 7.0.3 (or later)  

 
 
Note that iTunes Producer is not currently available for Windows or Linux (and don’t 
hold your breath for them either). 
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Installing iTunes Producer 
 
Now you will need to install iTunes Producer. First, you must have administrator rights 
to the computer you are installing it on. Double-click the iTunes Producer Installer icon 
and follow the instructions that appear. 
 
If you see a message that you do not have sufficient privileges to install this software, 
click the lock in the first screen of the installer window and enter an administrator name 
and password.  
 
The administrator users for your computer are shown in the Accounts pane of System 
Preferences. For more information, choose Help > Mac Help, and search for 
"administrator users." 
 
If you don't have Mac OS X 10.4.5 or later, visit http://www.apple.com/macosx/ . 
 
If you have Mac OS X 10.4 and need to update it to the latest version, choose Apple 
menu > System Preferences, click Software Update, and then click Update Now/Check 
Now.  
 
If you don’t have Quicktime to 7.0.3 or later, visit http://www.apple.com/quicktime/ . 
 
After you install an update, it's a good idea to click Update Now/Check Now again to 
make sure you've received all the latest versions. 
 
AppleCare support is not available for iTunes Producer. If you have feedback regarding 
the use of the iTunes Producer software or your Apple Developer Connection account 
login information, you can send email to iTunesProducer@apple.com . 
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Encode. Upload. 
 
After you open iTunes Producer, you need to complete four steps to submit your music 
to the iTunes Music Store: 
 

1. Create a playlist. 
2. Import your music. 
3. Describe each track. 
4. Send your playlist to Apple. 

 
IMPORTANT: In iTunes Producer, fields with an asterisk (*) beside them must 
be filled out before you submit your playlist to Apple. Fields without asterisks 
are optional. 

 

Creating A Playlist 
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Your playlist should contain all the songs in each album or compilation that you want to 
submit to the iTunes Music Store. You need to create a playlist even if you just want to 
submit one song. If you want to submit an album that has several volumes, you must 
include all volumes in the same playlist. 
 
 
1. Click the Add button in the bottom-left corner of the iTunes Producer window, and 

name the playlist. 
 
2. In the Playlist pane, select the Language of the playlist. Important: Select 

"Japanese" only in regards to music of Japanese origin. 
 
3. Enter the title of the album in the Title field. For Japanese-language playlists, enter 

the Japanese, Phonetic, and English spellings of the title. 
 
4. If there are multiple versions of this album, enter a description for this version (for 

example, "Remastered," "Bonus Track Version," or "Extended Version") in the Title 
Version field. 

 
5. Enter the name of the primary artist on the album in the Artist field. If there is more 

than one primary artist, choose one artist's name to enter in this field, then add 
additional primary artists by clicking the More button. For Japanese-language 
playlists, enter the Japanese, Phonetic, and English spellings of each artist. 
Important:  If you enter more than one artist or group name in the Artist field, your 
playlist will not be processed correctly. And DO NOT TYPE IN ALL CAPITAL 
LETTERS - For Emphasis, Please Use Initial Capital Letters Only.  
 
If you are creating a playlist that includes a compilation of artists, type "Various 
Artists" in the Artist field. (Later, you will need to enter an artist name for each 
individual track.) 
 
To add additional artists or other contributors (song writers, remixers, producers, and 
so on), or to enter a website URL for the primary artist, click the More button to the 
right of the Artist field. To add a new name, click the New button in the bottom-left 
corner of the Artists window. To edit the name, website, or role for anyone in the list, 
select the artist and click Edit. NOTE: Only artists on the front cover or spine of the 
CD should be listed as having a "primary" role. 
 
When you’re done adding artist information, click OK to close the Artists window. 

 
6. Choose a genre for the album from the Genres pop-up menu. If applicable, choose a 

second genre for the album from the second pop-up menu, or type the name of a 
different genre. 

 
7. Enter the name of the label that released the album in the Label field. 
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8. Enter the year (YYYY) the album was copyrighted in the first Copyright field, and 

then enter the copyright owner in the field to its right. Do not type the word 
"copyright" or include the copyright symbol in these fields. 
 

9. Enter the year (YYYY) the sound recording for the album was copyrighted, and then 
enter the copyright owner for the album in the field to its right. Do not type the word 
"copyright" or include the copyright symbol in these fields. 

 
10. Enter a valid 12-digit UPC (Universal Product Code) or 13- or 14-digit EAN 

(European Article Number) or JAN (Japanese Article Number) for the album in the 
UPC/EAN/JAN field. Be sure to include the check digit. 

 
Important: A unique code is required for each playlist. Any new playlist 
that is submitted with a previously-used code will not be added to 
iTunes. 

 
11. Choose the region where you have rights to sell this playlist from the Territory Rights 

pop-up menu. Only include those territorial rights that you have existing rights for. 
You can add territorial rights later on after you submit your music to iTunes Music 
Store. 

 
 If you don't see a region that includes only the countries where this playlist can be 
sold, choose Territory Rights > Custom, and then select all the countries where this 
playlist can be sold. To add your custom territory list to the menu (so you can use it 
for future playlists), choose Territory Rights > Edit List, then create and save your 
list. 

 
12. Choose a price for this playlist from the Suggested Retail Price popup menu. The 

album price cannot be higher than the sum of the prices for each track. The 
suggested retail price for each track you submit will be automatically set at US 
$0.99, 0,99 € , £ 0.79, or CAN $0.99, depending on the country you're in. 

 
13. Enter the date (YYYY-MM-DD) on which the album was or will be released in the 

Release Date field. Important: Make sure you OS system date and time are 
correctly set. 

 
14. Enter the date on which the album should be made available for sale in iTunes in the 

Sale Start Date field. The album will then be made available for sale on this date in 
all countries. To set the Sale Start Date on a per-country basis, first enter a Sale 
Start Date in the Sale Start Date field. Then go into the Territory Rights pop-up menu 
and select "Custom." You can modify the Sale Start Date for a particular territory by 
editing the date displayed in the Sale Start date column at the right side.  

 
Albums won't be shown in the store until the specified Sale Start Date. If you don't 
specify a Sale Start Date, the album will be available for sale as soon as it is added 
to iTunes.. 
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15. For albums that are re-releases, enter the year (YYYY) in which the original album 

was released in the Original Release Year field. 
 
16. If applicable, choose a parental advisory notice from the Parental Advisory pop-up 

menu. 
 
17. To include where the album was made, describe the recording location in the 

Recording Location field. For example, "FreddyMax Recording Studios, Columbia, 
California." 

 
18. To enter any liner notes for this album, click Edit. 
 
19. Drag at least a 600 x 600 pixel TIFF, JPEG, or PSD file (Best quality, RGB Color 

mode) of the album's cover art to the Cover Art box. Please do not submit back 
cover or "thumbnail" art.  

 
For best results, deliver the largest pixel dimensions possible (e.g. 1200 x 1200 
pixels). DO NOT scale up artwork if smaller than the required size of 600 x 600 
pixels. "Scaling up" means increasing the size of the image without re-scanning or 
re-importing the original art. If you are scanning your cover art be sure to scan at the 
highest resolution or at least 600 x 600 pixels. "DPI" setting does not matter. 
 
DO NOT submit art that contains an embedded color profile. 
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Importing Your Music 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Next, click Import at the bottom of the iTunes Producer window to add your music to this 
playlist. For more information, follow the steps below. You can import the music that you 
want to include in your playlist from a CD or from files on a connected hard disk. 
 
 
 
1. Click Import at the bottom of the iTunes Producer 

window. 
 
2. To import music from a CD, insert the CD that 

contains the songs you want to add to this playlist, 
uncheck any songs you don't want to be imported, 
and then click the Import button below the list of 
songs on the CD. 
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To uncheck all the songs, press the Command key 
and click a checkbox. To select all the songs again, 
press the Command key and click again. 

 
3. To add files from your desktop to the playlist, click 

Add (below the Files list), and then click the Import 
button below the Files list. 

 
 
 
 
 

Describing Each Track 
 
Click the Tracks button at the bottom of the iTunes Producer window to enter 
information about each track on this playlist. For more information, follow the steps 
below. You need to enter information for each song in the playlist to have them appear 
correctly in the iTunes Music Store. 
 
1. Click Tracks at the bottom of the iTunes Producer window. 
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By default, information you entered about the playlist may appear in some fields. 
You only need to change the information if it's different for the track, or add 
information if it's missing. 

 
2. Select the song you want to describe at the top of the Tracks pane. 
 
3. Enter the title of the song in the Title field. For Japanese-language playlists, enter 

the Japanese, Phonetic, and English spellings of the title. Important: DO NOT 
TYPE IN ALL CAPITAL LETTERS - For Emphasis, Please Use Initial Capital Letters 
Only. 

 
4. If there are multiple versions of this song or if you'd like to provide any additional 

identifying information, enter a description for this version (for example, "Remix," 
"Hidden Track," "Bonus Track," or "Live") in the Title Version field. For Japanese-
language playlists, enter the Japanese, Phonetic, and English spellings of the Title 
Version. 

 
5. If the primary artist for this track is different than the artist listed for the entire playlist, 

enter the name of the primary artist on this song in the Artist field. If there is more 
than one primary artist, choose one artist's name to enter in this field, and then add 
additional primary artists by clicking the More button. Important : If you enter more 
than one artist's name in the Artist field, your playlist may not be processed correctly. 
 
If you entered "Various Artists" as the primary artist for this playlist, you must now 
enter the name of the primary artist on this track. Do not put "Various Artists" as an 
artist name for any track. 
 
To add additional artists or other contributors (song writers, remixers, producers, and 
so on), or to enter a website URL for the primary artist, click the More button to the 
right of the Artist field. To add a new name, click the New button in the bottom-left 
corner of the Artists window. To edit the name, website, or role for anyone in the list, 
select the artist and click Edit. 
 
When you’re done adding artist information, click OK to close the Artists window. 

 
6. Choose a genre for the song from the Genres pop-up menu. If applicable, choose a 

second genre for the song from the second pop-up menu. 
 
7. Enter the track number for this song in the Track Number field. 
 
8. Enter the number of seconds into the song that the preview should start playing in 

the Preview Start field. The preview will play from this point for 30 seconds. If you 
leave this field blank, the preview will start at 30 seconds unless the song is less 
than 30 seconds in length, in which case it will start at the beginning. 

 
9. Enter the volume on which this song appears in the Disc Number field. 
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10. Enter the beats per minute for this song in the BPM field. 
 
11. Enter the name of the label that released the song in the Label Name field. If you 

leave this field blank, the label name from the playlist is used. 
 
12. Enter the year (YYYY) the sound recording was copyrighted in the first Copyright 

field, and then enter the copyright information in the field to its right. Do not type the 
word "copyright" or include the copyright symbol in these fields. 

 
13. Enter the ISRC code for the song in the ISRC field. iTunes will not accept 

your music without this code. There’s more information about ISRC 
codes in the Bonus Section at the end of this guide. 

 
14. For Japanese language playlists, select the Per-Track Suggested Retail Price. 
 
15. If the song should be made available for sale, select the checkbox to the left of 

Cleared For Sale. By default, the song will be available for sale on the album's sales 
start date. 

 
16. If the song is part of a gapless album, select the checkbox to the left of Part of a 

Gapless Album. Gapless playback means that there is no pause in playback 
between the end of one audio file and the beginning of the next audio file. Gapless 
playback is always on in iTunes 7 or later unless the Crossfade feature is turned on. 
If Crossfade is on, only audio files that have the "Part of a Gapless Album" option 
checked and are capable of being played gaplessly will play with no gaps.If 
applicable, choose a parental advisory notice for this song from the Parental 
Advisory pop-up menu. 

 
17. If applicable, choose a parental advisory notice for this song from the Parental 

Advisory pop-up menu.  
 
18. To include where the song was recorded, describe the recording location in the 

Recording Location field. For example, "FreddyMax Recording Studios, Columbia, 
California."  

 
19. To enter this song's lyrics, click the Lyrics Edit button, then copy the lyrics from a text 

document and paste them into the field that appears. 
 
20. Review all the information that you've entered in the Tracks, Playlist, and Import 

panes. 
 

IMPORTANT: Make sure there are NO typing mistakes or other 
errors. There are some details that can’t be changed after you 
submit them. Read the “Changing Playlists You’ve Already 
Submitted” section below BEFORE you submit anything. 
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Sending Your Playlist To Apple 
 
When you are sure the playlist and track information is complete and correct, you can 
send your playlist to Apple to be processed for the iTunes Music Store. 
 
 
1. Click Send at the bottom 

of the iTunes Producer 
window. 

 
2. Enter your Apple ID and 

password. 
 
3. If you want to add this 

project to a list of playlists 
that are ready to send to 
Apple, click "Add to 
Queue."  

 
If you plan to submit 
multiple playlists or have 
an intermittent Internet 
connection, you may 
want to wait to send this 
playlist until all your playlists are ready, and then send them all at one time. 
 
To remove a playlist, select it in the Queued Playlist list, then click Remove. 

 
4. To see a summary of all the information for one playlist, select the playlist in the 

Queued Playlists list, then click View Summary. To see a summary for all playlists in 
the Queued Playlists list, make sure all playlists are selected and click View 
Summary. 

 
5. When you're ready to send this playlist (and any queued playlists) to Apple, click the 

Send button below the Queued Playlists list. 
 

Note: It will probably take several weeks until you see your playlist in the iTunes 
Music Store. Also, if you upload your playlist in August, September or October, it 
may take significantly longer to appear in the iTunes Music Store than at other times 
of the year. Why? Because everyone (and their dog) wants their music to be 
released in time for the Christmas holidays. 
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Importing data from a tab-delimited file 
 
You can import playlist and track data from a tab-delimited file instead of hand entering 
the data. Your data must be contained in a tab-delimited (encoded in UTF-16 format) 
file.  
 
To import data into your playlist/s you must do the following before you can import data: 
 

1. Create a new playlist for each album you want to encode.  
 

2. Add the UPC or EAN to each playlist. 
 

3. Import your music in the final track order for each playlist. It is imperative that you 
import your music in the final track ordering so that your track-level data will 
import in the proper order. 

 
4. Choose File > Import Data... 

 
5. Select the tab-delimited file that contains the data you want to import.  

 
Please note: Any fields that cannot be imported will be displayed as "Skipped 
Fields." This includes field names that are misspelled or contain fields that are 
not acceptable for import (see below for a list of data that can be imported). 

 
6. Select which UPC/EANs you want to import by either holding down the Shift or 

Command key when clicking the mouse button. If you want to import data for ALL 
UPC/EANs in your tab-delimited file then you don't need to select any 
UPC/EANs, just choose Import. 

 
The following fields can be imported into an iTunes Producer playlist. You must ONLY 
include field names for the data you want to import. For any field that you do not have 
data, iTunes Producer will import the blank data and overwrite any previously entered 
data.  
 
Important: Be sure to spell these field names correctly or the data for misspelled fields 
will be skipped.  
 
In order to successfully import data you MUST include data for either a UPC, EAN, or 
JAN field (choose ONLY ONE product code to name the field), Album Title, Album 
Artist, Track Title, Track Number, and Disc Number. 
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"UPC" or "EAN" or "JAN" (Required Field. Choose ONLY ONE product code to name the field: 
Either "UPC" or "EAN" or "JAN") 
Language 
Album Title (Required Field) 
Album Phonetic Title 
Album English Title 
Album Title Version 
Album Phonetic Title Version 
Album English Title Version 
Album Artist (Required Field) 
Album Phonetic Artist 
Album English Artist 
Album Genre 
Album Genre 2 
Album Label Name 
Album Copyright Year 
Album Copyright 
Album P Copyright Year 
Album P Copyright 
Release Date 
Sale Start Date 
Original Release Year 
Album Parental Advisory 
Album Recording Location 
Track Title (Required Field) 
Track Phonetic Title 
Track English Title 
Track Title Version 
Track Phonetic Title Version 
Track English Title Version 
Track Artist 
Track Phonetic Artist 
Track English Artist 
Track Genre 
Track Genre 2 
Track Number (Required Field) 
Total Tracks 
Disc Number (Required Field) 
Total Discs 
Preview Start 
BPM 
Track Label Name 
Track P Copyright Year 
Track P Copyright 
ISRC 
Cleared For Sale 
Track Parental Advisory 
Track Recording Location 
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Important: Please read the following import rules: 
 

1. These six fields are REQUIRED to successfully import your data: "UPC" or 
"EAN" or "JAN," Album Title, Album Artist, Track Title, Track Number, and Disc 
Number. 

 
2. Only include the field names for the data you want to import. Any fields that 

contain empty or blank data will be imported as blank data and will overwrite any 
existing data. 

 
3. All rows of data must be contiguous. To import data successfully, there can be no 

blank rows of data between any two rows of data. 
 

4. You can reimport data multiple times. 
 

5. For the Genres and Parental Advisory field, which appear as pop-up menus in 
iTunes Producer, the data you import must exactly match the menu choices. 

 
6. If you have a mix of UPCs and EANs, for example, you must choose ONE FIELD 

NAME and enter both types into the same field (e.g. both UPCs and EANs must 
go in the "UPC" field). 

 
7. If you are using Excel to save your data as a "Unicode Text UTF-16" file, be sure 

to review the data BEFORE you save the file. Excel can automatically remove all 
leading zeros from your UPC, EAN, and JAN numbers and also save the 
numbers in scientific notation. Reviewing your data before you save the file as a 
"Unicode Text UTF-16" file can avoid this issue. 

 
8. If you are using Excel, to ensure your UPC, EAN, and JAN numbers do not have 

leading zeros removed and are not displayed in scientific notation, first select the 
UPC, EAN, or JAN column in your spreadsheet. Choose Format > Cells and 
select "Text" for the category. Now you can properly enter your UPC, EAN, and 
JAN numbers in the cells. 
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Changing Playlists You’ve Already Submitted 
 
If you make changes to the playlist after you click Send and want to submit your changes to 
Apple, follow the instructions below.  
 
If you need to make a change to a playlist after you've submitted it to Apple, do the following: 
 

1. Open the playlist you want to edit. 
 

2. Choose Edit > Edit Playlist 
 

3. Make your changes. When you're ready to resubmit the playlist, click Send at the bottom 
of the window, then click the Send button below the Queued Playlists list. 

 
If you resend your playlist via iTunes Producer, only the following attributes will be updated: 
 

• Audio files 
• Wholesale price tier 
• Additions to Territory Rights 
• Sales start date 

 
You can also log into you Label Connect account to add Territory Rights. Click on the Add 
Rights to Your Albums link from Label Connect's main page, and you can submit a comma-
separated list of UPCs/EANs and add territory rights where you have an executed contract.  
 
If you need to change one or more of the items listed below, you must do it via the Contact Us 
page in Label Connect. The following changes made in iTunes Producer will be ignored: 
 

• Album Title 
• Artist Name 
• Song Titles 
• Cover Art 
• Album Price 
• Removing Territory Rights 

 
Unfortunately, there is some information that cannot be changed once it has been submitted, 
specifically: 
 

• UPC / EAN 
• JAN 
• ISRC 
• Preview Start Time 

 
Note: Making changes to a previously submitted playlist may delay your playlist from appearing 
on the iTunes Store.  
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Marketing Your Music on iTunes 
 
Apple has developed several programs for marketing music on iTunes. One thing to 
remember here is that you don’t market your music on iTunes. You market your music 
on iTunes. In other words, you need to drive traffic (your fan base, mom, dad, aunts, 
uncles and pet cat) from everywhere else on the Internet to iTunes, and more 
specifically, to download your music from iTunes. This is the only way you will get paid. 
 
 
The marketing program information can be found here: 
 
http://www.apple.com/itunes/musicmarketing/ 
 

iTunes Link Maker 
Use the iTunes Link Maker to create direct web links to any artist, song, or 
album on iTunes. Use it to merchandise music on your own websites. 
 

iTunes RSS Feeds 
iTunes RSS Feed Generator lets you get hourly updates to top albums, songs, featured 
content and more via RSS. 
 

Tell-a-Friend 
Tell-a-Friend is a viral email marketing tool built into iTunes to help you generate buzz 
and link fans directly to your artists and albums in iTunes. 
 

iTunes Custom Cards 
iTunes Custom Cards are an exciting new promotional tool for record labels, artist 
managers, and promoters to distribute music to fans. Ideal for contests, giveaways, or 
physical distribution to radio, custom cards are the perfect replacement for promotional 
CDs, and in many cases less expensive. The front of the card presents a special 
custom design while the back contains a unique download code for the specific song or 
album on iTunes. Overall pricing varies depending on volume. For information on 
ordering custom cards, please email itunescustomcards@apple.com. 
 

iTunes Affiliate Program 
Link directly from your website to any song, album or artist on iTunes and 
start earning commissions on every sale. 
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Google AdWords 
iTunes and Google have teamed up to create a special offer 
exclusively for iTunes label. Purchase keyword advertising from 
Google and get a one-time promotional discount when you link to 
your music on iTunes. 
 

iTunes Gift Certificates 
iTunes Gift Certificates are available for gifts, contests and giveaways. 
Choose an amount between $10 and $200. Certificates are available 
either printed or electronically emailed to the recipient. 
 

iTunes Logos and Guidelines 
Contact the iTunes Music Marketing team to request iTunes logos for print, TV or web 
use. 
 

iTunes Public Relations Support 
Contact the iTunes PR team for assistance in publicizing the availability of your music 
on iTunes. 
 

iTunes Volume Discount Program 
Record labels, radio stations and trade organizations can now purchase iTunes song 
downloads in bulk through the iTunes Volume Discount Program. Song downloads are 
great for promotional giveaways, incentive programs, sweepstakes prizes and other 
valuable customer offers. 
 

Apple Retail Stores 
When your music is added to iTunes, it is considered for inclusion in demo 
computers and in-store play at over 75 Apple Store locations nationwide. 
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ISO Standard ISO 3901: ISRC Codes 
 
International Standard Recording Code (ISRC) codes are a global, unique method of 
identifying sound and music video recordings. The ISRC has been developed in order to 
facilitate the accurate exchange of information on the ownership, the use of recordings 
and to simplify the administration of rights. 
 
By identifying all sound and music video recordings that are released, regardless of the 
format that they are released in, the ISRC enables the tracking and tracing of these 
recordings through the music value chain. 
 
Potential users of sound and music video recordings will also find it easier to obtain 
information about the current rights owner because repertoire databases will provide 
this information with the ISRC. 
 
In addition, in many territories the ISRC is increasingly becoming a tool in the fight 
against piracy. 
 
The adoption of the ISRC system by the music community as a whole has the 
following benefits: 
 

• ISRC, being the worldwide recognized standard for recording identification, can 
easily be accepted and implemented internationally and allow interoperation of 
different databases and systems. 

• The ISRC coding system is compatible with standards developed in the field of 
consumer electronics. Incorporated in appropriate digital and manufactured 
recording media it is readable by hardware equipment. 

• The ISRC is increasingly used in electronic copyright management systems and 
Digital Rights Management systems. 

• The implementation of ISRC is cost effective; ISRC can be put into operation 
without requiring special investment in equipment. It only requires a structure 
able to deal with the administration of ISRC within the organization using it. 

 
The ISRC system has a number of fundamental principles, which include: 
 

• Each distinct recording is to have its own unique ISRC 
• The first owner or current owner of the rights to a recording normally assigns the 

ISRC, providing no ISRC has previously been issued. This identifies the 
recording throughout its life and is intended for use by producers of sound 
recordings and music videos (i.e. record labels), as well as by copyright 
organizations, broadcasting organizations, libraries, licensees etc. 

• Any new or materially changed recording must be provided with a new ISRC. Re-
use of an ISRC already allocated to another recording is not permitted. 

• If a recording is sold or licensed and is then released unchanged the ISRC 
remains the same. 
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The International Registration Authority for ISRC is the IFPI Secretariat. To be assigned 
ISRC codes, you will need to contact your national ISRC agency. The IFPI Secretariat 
web site is at the following address and has the contact information for each national 
ISRC agency: 
 

http://www.ifpi.org/isrc/ 
 
In the bonus section of this guide, there’s a much fuller explanation of what an ISRC 
code looks like. This was supplied by the RIAA (the US national agency for ISRC 
codes). Also in the bonus section (for US residents only), there is the RIAA’s ISRC 
application form.  
 
If you are not in the US, you will need to contact the National ISRC Agency for your 
territory. An up to date, alphabetical list is available here: 
 

http://www.ifpi.org/isrc/isrc_agencies.html 
 
If there is no ISRC Agency in your territory, you can obtain an ISRC from the 
International ISRC Agency by sending an email to: isrc@ifpi.org
 
 
It is also a good idea to read the ISRC FAQ which answers most questions. It can be 
found here: 
 

http://www.ifpi.org/isrc/isrc_faq.html 
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Bonus Materials 
 
On the following pages you will find some important reference materials... 
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BREAKING OUT THE CODE
THE INTERNATIONAL STANDARD RECORDING CODE (ISRC) PROGRAM:

AN EXTREMELY POWERFUL TOOL FOR ROYALTY COLLECTION, ADMINISTRATION,
AND ANTI-PIRACY SAFEGUARDS IN THE DIGITAL ARENA.

THE ISRC COMPRISES 4 CODES:

COUNTRY CODE: The country where the
registrant’s (sound recording copyright owner)
home office is located (2 characters).

REGISTRANT CODE: The
code of the registrant that
allocated the ISRC (3
characters).

YEAR OF REFERENCE
CODE: The year in which the
ISRC is allocated to the
recording (2 digits)

DESIGNATION CODE: The code assigned to the
sound recording by the registrant. This code may not
be repeated within the same calendar year (5 digits).

Sample ISRC: ISRC US-B4U-04-00001
For visual presentation, the letters “ISRC” should always precede the ISRC and the sub-codes should be separated by hyphens.

BACKGROUND
This is an exciting time for the music business. Technology is changing the entire
concept of the music industry’s “product.” The recording industry is taking important
steps to facilitate digital music broadcasting and digital phonorecord delivery by
implementing the International Standard Recording Code (ISRC).

Registrant Code
In 1998, the Registrant Code replaced the First Owner Code. The First Owner Code
identified the initial owner of the copyright in the sound or music-video recording.
The Registrant Code now identifies the registrant of the recording when the ISRC is
allocated.

WHAT IS THE INTERNATIONAL STANDARD RECORDING CODE?
The ISRC is a unique international identifier for sound and music video recordings. It
comprises a 12 character alphanumeric code, the ISRC functions as a universal serial
number for each sound recording. Unlike the Universal Product Code, the ISRC is
tied to the track and not the carrier of the track (CD, cassette). In addition, the ISRC
remains allocated to a sound recording regardless of changes in ownership. It is an
extremely powerful tool for royalty collection, administration and anti-piracy
safeguards in the digital arena.

HOW IS IT USED?
The ISRC is usually assigned by the first owner of a sound recording, or track
(usually a recording company). The owner of the sound recording applies for a
registrant code from the national agency for the country where the owner resides. In
the US, that agency is the Recording Industry Association of America (RIAA). Once
the RIAA has issued a Registrant Code, the owner may then allocate ISRCs for each
individual sound recording that is to be released to the public.

ISRCs can be embedded in many digital sound carriers. They are stored as PQ codes
on Red Book audio CDs and they are inserted in the data stream during the pre-
mastering process. Additional details are available in the FAQ that follows.

ISRC GUIDELINES
The International Federation of the Phonographic Industry (IFPI) issued Practical
ISRC Implementation Guides in 1991, 1994, 1995, 1998, and 2003. The majority of
the provisions contained in these publications are similar. Each one, however,
outlines important changes in policy. To ensure that the latest ISRC implementation
standards are followed, the changes are outlined herein.

Phonogram and Videogram Registrant Codes
The registrants are assigned separate Registrant Codes for Phonograms and
videograms in order to distinguish between the two.

Year of Reference Code
In 1998, the Year of Reference Code replaced the Year of Recording Code, which
identified the year the sound recording was recorded. The Year of Reference Code
now identifies the year in which the ISRC is assigned to the recording.

Designation Code
In 1994, the five digit Designation Code replaced the three/four digit Recording Code
and the one/two digit Recording Item Code outlined in the 1991 Implementation
Guide. The Designation Code consists of five digits and should preferably be
assigned sequentially. Care should be taken to ensure that Designation Codes are not
re-used within a calendar year.

Separate Exploitation
If at any time in the future the asset may be separately exploited (this does not
necessarily imply monetary value), then an ISRC should be allocated. Examples
include: 30-second clips, hidden tracks, interludes, callouts, and skits.

Encoding ISRC
The ISRC is encoded at the mastering stage of the recording. In the case of music
videos, the ISRC appears in the time clock for all analog formats and on the label
outside of the box.

FOR MORE INFORMATION
Please visit the Recording Industry Association of America’s web site at
www.riaa.com, or contact Laura Coker or Carlos Garza at +1 202-775-0101 or send
an email message to isrc@riaa.com.
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Frequently Asked Questions about ISRC

Q.What exactly is an ISRC?
A. ISRC is a unique identifier for sound and music video recordings where one, and only
one, identifying code is allocated to each version of a recording. For code allocation
purposes, the ISRC is separated into its different elements. However, when the code is
being used, it is the complete code that represents the sound or music video recording and
no significance should be accorded to any one element.

In particular, the Registrant Code cannot be assumed to identify a current rights owner as
the recording may have changed ownership since code allocation. Additionally, rights
may vary territory by territory. Further, the year of reference cannot be assumed to be a
year of recording. It represents the year the ISRC was assigned, which may or may not
be the year the sound recording was released.

Q.What is the difference between a “sound recording” and a “track”?
A. A “sound recording” is the fixation of a musical work in an auditory format. A full-
length release, such as an album, will contain several sound recordings. Each sound
recording usually contains one musical work of authorship (medleys are an exception).

The instantiation of a sound recording on a release is called a “track.” A Sound recording
can appear as different tracks on different releases. For example, track 3 on your first
album could appear as track 1 on a greatest hits album or compilation. If the sound
recording is the same then each track should carry the same ISRC.

Q. What does it cost?
A. The RIAA currently does not charge a fee for assignment of Registrant Codes or
answering questions on the ISRC program. Your implementation of the ISRC is cost
effective. It can be done without special investment in equipment or technological
measures. It only requires you to develop an internal system for administering ISRCs.

Q.How do I create ISRCs?
A. The first step is to apply for a Registrant Code for your recording company. This code
can be obtained from RIAA, the national ISRC administration agency for the United
States. Membership in the RIAA is not required to obtain a Registrant Code. RIAA
strongly encourages all U.S. sound recording copyright owners to apply for an ISRC
Registrant Code and assign ISRCs to all sound recordings that are planned for release.

Q. How do I apply for a Registrant Code?
A. The application form for a Registrant Code can be obtained through the contacts above
or downloaded from the RIAA web site: http://www.riaa.com/issues/audio/isrc_faq.asp

Q. Who is responsible for assigning ISRCs?
A. The first owner of the rights to the sound recording usually assigns an ISRC.
However, if the first owner of the track did not assign the ISRC, then the current owner
should assign it using the current owner’s Registrant Code.

Q. How long is an ISRC good for?
A. Once assigned, the ISRC identifies the track throughout its life. No other sound
recording should have the same ISRC and only one ISRC should be used to identify a
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sound recording. ISRC functions like a vehicle identification number on a car or a serial
number on a piece of equipment.

Q. Does change in ownership affect ISRC?
A. Changes in ownership do not affect the ISRC. An ISRC must be assigned to every
track on a phonogram or videogram. When an unchanged sound recording is reused on a
new phonogram or videogram, a new ISRC should not be applied even if there is a new
owner of the sound recording.

Q. When must a new ISRC be allocated?
A. A new ISRC must be allocated when:
1. A sound recording is re-mixed or edited
2. If a new fade changes the length of a track by more than 10 seconds.
3. Edits that change the length of a sound recording by more than 10 seconds
(playing time is measured from the first recorded modulation to the last recorded
modulation).

4. A previously released sound recording is partially used as part of a compilation.
5. A “full restoration” of a historical recording is performed by re-mastering, re-
pitching, re-equalizing, de-noising or de-clicking a sound recording to meet
contemporary quality standards. The registrant of the recording has discretion
when making the determination between full re-mastering (sound restoration) and
simple re-mastering (reproduction without sound restoration).

**This is not a complete list of instances that require new ISRCs for previously
designated sound recordings. For a complete description of situations that require a
new ISRC, please consult the 2003 ISRC Handbook available at www.ifpi.org.

Q. What if I change the name of my song?

A. If a company decides to change the title of a sound recording, with no alterations to
the sound recording track itself, we recommend keeping the same ISRC.

Q. What if a sound recording has more than one copyright owner?
A. One company in the split ownership must be responsible for the ISRC assignment.

Q. Can I register a track that has been previously issued, but never assigned an
ISRC?
A. Yes. Although an ISRC should be assigned by the first owner, this does not always
happen. The current owner can assign ISRCs for sound recordings that have not been
assigned ISRCs by their first owners. The Registrant Code will be that of the current
owner of the rights and the Year of Reference Code will be the year the ISRC was
assigned.

Q. What do I need in order to assign ISRCs to my sound recordings?
A. First, the owner of a sound recording needs a Registrant Code. You can find the ISRC
Registrant Code Request form at the RIAA web site. For more information, contact us
by e-mail (isrc@riaa.com) or at (202) 775-0101.

Q. Do I have to be a member of RIAA to apply for a Registrant Code or request
information about the ISRC program?
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A. No. RIAA is the national administrator of the ISRC program in the United States, and
as such does not require membership to assign Registrant Codes or provide information
to sound recording copyright owners.

Q. How long does it take the RIAA to assign a Registrant Code?
A. It can take up to one week from the day we receive the request form. The request
form can be faxed to us at: (202) 775-7253 or scanned and emailed to: isrc@riaa.com

Q. Does a sound recording copyright owner only need a single Registrant Code?
A. It depends. If the sound recording copyright owner produces sound recordings and
music video recordings, it should have a separate Registrant Code for its sound and
music video recordings.

Q. How do I assign the Year of Reference Code?
A. This 2-digit code reflects the year in which the ISRC is assigned, irrespective of when
the sound recording was originally fixed or released.

Q. If recording rights are sold or transferred does the ISRC change?
A. No, if the sound recording remains the same, so should the ISRC.

Q. What should I do with the ISRC once I have it?
A. 1.) The ISRC should be allocated to a recording when a master is completed and the
decision to release a recording has been made. Once you have an ISRC it should be
encoded in digital sound carriers in the pre-mastering or authoring process in according
with the specification on the format used.
2.) We also strongly recommend that Registrants keep good records and ensure that

the details of the recording (the metadata) and the ISRC allocated are included in relevant
repertoire databases.

Q. Where can a sound recording copyright owner obtain a detailed copy of the ISRC
implementation guidelines?
A. Please contact the Technology Department of the RIAA (isrc@riaa.com) or the
International Federation of the Phonographic Industry (IFPI) on the web at www.ifpi.org
(isrc@ifpi.org).



US ISRC REGISTRANT CODE APPLICATION 
 

For RIAA use only 
date inits code 

 
 

 
 

 
Registrant Name: 

(Recording Owner or Label)  

 
      

 
Primary Contact 

Name:  

 
      

 
Primary Contact  

Job Title:  

 
      

 
Address line 1:  

 
      

 
Address line 2:  

 
      

 
City, State, Zip 

 
      

(Individual registrants and record companies must be located in the US.  If 
the Registrant is part of an international group, it must elect the country 

where the local operating entity or the international headquarters is located.  
For a list of international ISRC Agencies go to ifpi.org/isrc) 

 
 US telephone(s):  

 
      

 
US fax:  

 
      

 
Email Addresses:  

      
      

(Please write clearly and include one or more valid email addresses.  
The ISRC Registrant code & instructions will be sent to these email addresses.) 

 
Record Group:  

(If part of a group of labels) 

 
      

 
Distribution Company 

(if known and applicable):  

 
      

 
Signature: 

(REQUIRED)  

 
 

 
Application Date:  

 
      

 
Registrant Code requests are usually processed within 5 business days.  

Recording Industry Association of America 
1330 Connecticut Avenue, NW, Suite 300,  

Washington, DC 20036 
Phone: 202-775-0101 Fax: 202-775-7253  

Web: http://riaa.com 
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